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Introduction

This document outlines the bugs that were fixed in the ArcGIS 9.1 release.  For further information on any of these issues please contact your technical support representative.  

ArcGIS Desktop (ArcReader, ArcView, ArcEditor, ArcInfo)

	Bug #
	Product
	Area
	Bug Description

	CQ00262071
	ArcGIS Desktop
	.NET API
	Accessing application objects in ArcCatalog—CloseDocument generates .NET error

	CQ00220545
	ArcGIS Desktop
	3D Animation
	ENHANCEMENT—ArcGlobe needs a method to stop or cancel Export to Video

	CQ00228697
	ArcGIS Desktop
	3D Animation
	AVI options—Record Entire Window (video clipped)

	CQ00234497
	ArcGIS Desktop
	3D Animation
	Exporting to AVI—Using custom frame extents is broken

	CQ00236540
	ArcGIS Desktop
	3D Animation
	Component—IsceneExport3D.SceneExport crashes the application on blank documents

	CQ00240418
	ArcGIS Desktop
	3D Animation
	Feature shifts when recording an animation video when using time view or zooming in

	CQ00245242
	ArcGIS Desktop
	3D Animation
	Duration of exported QuickTime videos is half the duration set in the Animation Controls dialog box

	CQ00245717
	ArcGIS Desktop
	3D Animation
	ArcScene—Option to create camera animation in orthographic projection is broken

	CQ00250221
	ArcGIS Desktop
	3D Animation
	Exporting AVI—Video Compression dialog box disappears on some machines

	CQ00251695
	ArcGIS Desktop
	3D Animation
	When playing group layer animation tracks with a camera animation track, the animation is slower (jerky)

	CQ00254422
	ArcGIS Desktop
	3D Animation
	Usability issues with exporting animations to videos

	CQ00213069
	ArcGIS Desktop
	3D ArcGlobe
	3D Feature data with Z > 32767 are rendered erroneously underneath the globe surface

	CQ00228604
	ArcGIS Desktop
	3D ArcGlobe
	UI—When you start ArcGlobe, the Navigate tool is not active in the toolbar

	CQ00244276
	ArcGIS Desktop
	3D ArcGlobe
	Datasets that cross the dateline (-180.0 lat) need to be clipped to display the proper level of detail in Globe

	CQ00244532
	ArcGIS Desktop
	3D ArcGlobe
	Vectors disappear when anchor point is out of viewing area

	CQ00244604
	ArcGIS Desktop
	3D ArcGlobe
	ArcWeb Place Finder tool in ArcGlobe returns no results when locale is non-English

	CQ00244725
	ArcGIS Desktop
	3D ArcGlobe
	Unable to drape multipatch features on globe surface

	CQ00245704
	ArcGIS Desktop
	3D ArcGlobe
	ENHANCEMENT—Add support for WMS services to ArcGlobe

	CQ00248018
	ArcGIS Desktop
	3D ArcGlobe
	ArcGlobe does not recognize relates

	CQ00248186
	ArcGIS Desktop
	3D ArcGlobe
	Large feature datasets take forever to cache on demand in a tilted surface view, even with maximum visibility distance

	CQ00248403
	ArcGIS Desktop
	3D ArcGlobe
	Polygons with Zs have elevation options enabled that don’t apply or have any effect

	CQ00249962
	ArcGIS Desktop
	3D ArcGlobe
	Generating cache data for elevation layers added invisible generates empty tiles and corrupts subsequent data display

	CQ00251483
	ArcGIS Desktop
	3D ArcGlobe
	Overlapping elevation data (full cached) needs to behave in a consistent manner

	CQ00254011
	ArcGIS Desktop
	3D ArcGlobe
	Setting IglobeDisplay:ImmediateDataFetching to true will crash ArcGlobe if the document contains full cached raster datasets

	CQ00254490
	ArcGIS Desktop
	3D ArcGlobe
	PolygonZ-based feature layers get added as floating when they should be draped

	CQ00255041
	ArcGIS Desktop
	3D ArcGlobe
	Generating data cache from a group layer does not do anything

	CQ00255348
	ArcGIS Desktop
	3D ArcGlobe
	Vectors have incorrect near distance set turning them off when viewed from close range

	CQ00255589
	ArcGIS Desktop
	3D ArcGlobe
	Adding Web help to IDesktop: ArcGlobe

	CQ00256661
	ArcGIS Desktop
	3D ArcGlobe
	Opening docs with broken layers in TOC deletes these layers

	CQ00257470
	ArcGIS Desktop
	3D ArcGlobe
	UI match—Pause Data Caching tool should be able to start by F9 keyboard shortcut

	CQ00257784
	ArcGIS Desktop
	3D ArcGlobe
	When toggling between design and slide show (PowerPoint), nothing is displayed in GlobeControl when the doc contains IMS or MapServer

	CQ00258569
	ArcGIS Desktop
	3D ArcGlobe
	Turning an ArcSDE 8.3 catalog and file based raster catalogs on and off crashes ArcGlobe application

	CQ00259203
	ArcGIS Desktop
	3D ArcGlobe
	Generating full cache for global elevation (data specific) crashes application

	CQ00259774
	ArcGIS Desktop
	3D ArcGlobe
	Cube projected data do not display in ArcGlobe

	CQ00265253
	ArcGIS Desktop
	3D ArcGlobe
	Refreshing a feature layer with selection can cause the application to crash

	CQ00150842
	ArcGIS Desktop
	3D ArcScene
	ArcScene—Does not prompt for save if graphics are added

	CQ00158299
	ArcGIS Desktop
	3D ArcScene
	VRML—Can’t export VRML on an extruded feature layer

	CQ00161512
	ArcGIS Desktop
	3D ArcScene
	Related tables do not appear in ArcScene

	CQ00242006
	ArcGIS Desktop
	3D ArcScene
	Unable to locate (identify, select, target) this feature in ArcScene

	CQ00244292
	ArcGIS Desktop
	3D ArcScene
	ArcScene crashes if you use the Add Data dialog box and add an ArcIMS map service or .lyr based on an ArcIMS map service

	CQ00244435
	ArcGIS Desktop
	3D ArcScene
	Can’t locate (identify, select, target) extruded points

	CQ00249172
	ArcGIS Desktop
	3D ArcScene
	3D marker symbology orientation not maintained in 2D export

	CQ00258436
	ArcGIS Desktop
	3D ArcScene
	Geodatabase raster catalogs crash ArcScene

	CQ00259613
	ArcGIS Desktop
	3D ArcScene
	Selection on polygon features doesn’t show the highlighted polygon boundary

	CQ00262064
	ArcGIS Desktop
	3D ArcScene
	Save dialog that appears if you choose to save after quitting Scene without saving: bad dependencies on File>Export 2D dialog

	CQ00162298
	ArcGIS Desktop
	3D Geoprocessing
	3D toolbar—Unable to convert to 3D shapefile based on attribute that is not type DOUBLE

	CQ00234584
	ArcGIS Desktop
	3D Geoprocessing
	ArcGlobe and ArcScene—Temporary output (feature) layers don’t have Make Permanent functionality

	CQ00236903
	ArcGIS Desktop
	3D Geoprocessing
	RasterTin—Invalid default output workspace generated when input raster is PGDB or SDE

	CQ00237017
	ArcGIS Desktop
	3D Geoprocessing
	Use of Zfactor other than 1 does not change Zunit definition in projection

	CQ00237037
	ArcGIS Desktop
	3D Geoprocessing
	EditTin—2D features should look for default numeric height field

	CQ00237971
	ArcGIS Desktop
	3D Geoprocessing
	InterpolateShape fails to place output PGDB featureclass in a specified dataset

	CQ00243698
	ArcGIS Desktop
	3D Geoprocessing
	EditTin—Produces two layers within the TOC as well as ModelBuilder

	CQ00243932
	ArcGIS Desktop
	3D Geoprocessing
	TinRaster—No default values given for cellsize or observation point

	CQ00244132
	ArcGIS Desktop
	3D Geoprocessing
	Output feature classes should be rendered with logical symbology

	CQ00252054
	ArcGIS Desktop
	3D Geoprocessing
	TinNode and TinTriangle cause desktop applications to fail when using derived data in ModelBuilder

	CQ00254146
	ArcGIS Desktop
	3D Geoprocessing
	TinRaster—Output extent and snap raster create output with incorrect raster origin

	CQ00264366
	ArcGIS Desktop
	3D Geoprocessing
	TIN-based tools don’t autogenerate output name when the workspace environment is not set

	CQ00265372
	ArcGIS Desktop
	3D Geoprocessing
	ICommandItem.Execute throws error in custom GP tool only in ArcScene and ArcGlobe

	CQ00213219
	ArcGIS Desktop
	3D Symbols
	Thumbnail images for texture line symbols from 3D Basic.style are too small to see

	CQ00235298
	ArcGIS Desktop
	3D Symbols
	ArcScene—3D Marker Symbol missing in 2D exported images if draped on a surface

	CQ00254396
	ArcGIS Desktop
	3D Symbols
	SketchUp support should be part of the core install at 9.1

	CQ00182083
	ArcGIS Desktop
	3D TIN
	TIN—Zfactor is applied to TIN when saving edits or copying (i.e., Save/SaveAs)

	CQ00223643
	ArcGIS Desktop
	3D TIN
	Modifications to the Zfactor from the source tab are not reflected in ArcScene until there is a forced refresh

	CQ00249592
	ArcGIS Desktop
	3D TIN
	Slope and aspect renderers should not have shading on by default

	CQ00250575
	ArcGIS Desktop
	3D TIN
	Error: Failed to create TIN—Attempt made to access an empty geometry/object when using certain projections

	CQ00254886
	ArcGIS Desktop
	3D TIN
	Attempted use of old (rev 6.0) TIN crashes application

	CQ00257959
	ArcGIS Desktop
	Application Framework
	Remove IobjectStreamDebug from esriSystem.olb

	CQ00258004
	ArcGIS Desktop
	Application Framework
	Need VB accessible interface to complement IdocumentVersionSupport

	CQ00260664
	ArcGIS Desktop
	Application Framework
	Mxtools is not removing registry entries when unregistering

	CQ00228782
	ArcGIS Desktop
	ArcCatalog General
	UI—Privileges command in context menu for ArcSDE geodb items gives error message when accessing context help

	CQ00262132
	ArcGIS Desktop
	ArcCatalog General
	Enable the Subtypes tab for object classes in the Properties dialog box with an ArcView license

	CQ00263541
	ArcGIS Desktop
	ArcCatalog General
	ArcCatalog crashes when renaming a dataset while previewing an fclass inside it

	CQ00140926
	ArcGIS Desktop
	ArcMap Annotation/Labeling
	Can’t select or edit elements in any annotation group unless Default is turned on

	CQ00182527
	ArcGIS Desktop
	ArcMap Annotation/Labeling
	Annotation leader lines don’t stay anchored to features when dataframe is projected and rotated

	CQ00234382
	ArcGIS Desktop
	ArcMap Annotation/Labeling
	Edit Annotation tool—Should clear the selected set when map background is clicked like Select Features tool and Edit tool

	CQ00234391
	ArcGIS Desktop
	ArcMap Annotation/Labeling
	Smoothing over poster text path uses wrong threshold

	CQ00234762
	ArcGIS Desktop
	ArcMap Annotation/Labeling
	Reference scale should not round in Annotation Layer 

	CQ00234774
	ArcGIS Desktop
	ArcMap Annotation/Labeling
	Annotation Class (sublayer)—Annotation tab text symbol preview should list symbol name and/or number

	CQ00234778
	ArcGIS Desktop
	ArcMap Annotation/Labeling
	Annotation hyperlink text does not project on the fly

	CQ00234779
	ArcGIS Desktop
	ArcMap Annotation/Labeling
	Hyperlinks are shown for unplaced annotation

	CQ00238514
	ArcGIS Desktop
	ArcMap Annotation/Labeling
	Dynamic labels disappear when rotated with dataframe

	CQ00239124
	ArcGIS Desktop
	ArcMap Annotation/Labeling
	Select All Elements—Always selects contents of <Default> annotation group even when that group is turned off

	CQ00241499
	ArcGIS Desktop
	ArcMap Annotation/Labeling
	Coverage annotation display order is incorrect because draw order tag is not persisted correctly

	CQ00246871
	ArcGIS Desktop
	ArcMap Annotation/Labeling
	Bloated annotation can draw with a red box in some circumstances

	CQ00249097
	ArcGIS Desktop
	ArcMap Annotation/Labeling
	Add warning when attempting to delete symbols from the symbol collection in ArcCatalog

	CQ00249284
	ArcGIS Desktop
	ArcMap Annotation/Labeling
	Labels with text symbol backgrounds move when viewing unplaced labels

	CQ00250305
	ArcGIS Desktop
	ArcMap Annotation/Labeling
	Non standard SQL for annotation classes can cause a crash on feature update due to a lack of null cursor pointer check

	CQ00250725
	ArcGIS Desktop
	ArcMap Annotation/Labeling
	Provide a different default location when saving advanced label expressions

	CQ00252960
	ArcGIS Desktop
	ArcMap Annotation/Labeling
	Annotation Feature Class with a corrupt element crashes on draw

	CQ00253660
	ArcGIS Desktop
	ArcMap Annotation/Labeling
	Feature Layer Labels Tab text preview does not update when changing size unless you click on the text in the combobox

	CQ00253770
	ArcGIS Desktop
	ArcMap Annotation/Labeling
	ArcMap crashes while converting vertical Japanese labels to annotation

	CQ00256370
	ArcGIS Desktop
	ArcMap Annotation/Labeling
	ArcMap crashes on exit after changing the line or fill color of a paragraph text element

	CQ00260285
	ArcGIS Desktop
	ArcMap Annotation/Labeling
	Bezier function used while editing annotation leaks

	CQ00260287
	ArcGIS Desktop
	ArcMap Annotation/Labeling
	Remove restrictions for the creation of multiple annotation subclasses for ArcView licenses

	CQ00099146
	ArcGIS Desktop
	ArcMap Data Frames
	Scale in Scale Control on Standard toolbar should be updated at the beginning of draw

	CQ00141908
	ArcGIS Desktop
	ArcMap Data Frames
	Bookmark scale changes after saving .mxd

	CQ00170051
	ArcGIS Desktop
	ArcMap Data Frames
	Back to Previous Extent button does not maintain all scales correctly

	CQ00180488
	ArcGIS Desktop
	ArcMap Data Frames
	Scale dependencies lost when zoom to next extent = 1 map scale unit above divide

	CQ00232397
	ArcGIS Desktop
	ArcMap Data Frames
	Map scale changes after zooming page and approving (OK) DF properties

	CQ00232501
	ArcGIS Desktop
	ArcMap Data Frames
	Panning the map with the scroll bar creates extra entries in extent history

	CQ00237386
	ArcGIS Desktop
	ArcMap Data Frames
	ToolbarControl—Previous extent command work properly after full extent

	CQ00244799
	ArcGIS Desktop
	ArcMap Data Frames
	Must click Zoom to Previous Extent button three times for it to work

	CQ00245811
	ArcGIS Desktop
	ArcMap Data Frames
	Map scale won’t stick if data frame has very small height on landscape page

	CQ00247598
	ArcGIS Desktop
	ArcMap Data Frames
	Map scale incorrect when page units are centimeters, and data frame scale switched between fixed and automatic

	CQ00248893
	ArcGIS Desktop
	ArcMap Data Frames
	Selecting the Size and Position tab changes the map scale

	CQ00249575
	ArcGIS Desktop
	ArcMap Data Frames
	Map ExtentStack contains invalid entries

	CQ00258779
	ArcGIS Desktop
	ArcMap Data Frames
	Clip data frame with features with query on joined table crashes

	CQ00245660
	ArcGIS Desktop
	ArcMap Desktop Help
	Code for Export the current view in the Sample VBA Code topic needs to be replaced

	CQ00069098
	ArcGIS Desktop
	ArcMap General
	Identify Results window—Arrow keys let you navigate selected features but changes are not flashed (section 508)

	CQ00078791
	ArcGIS Desktop
	ArcMap General
	Identify Results window—Can’t copy values from Identify Results window

	CQ00149812
	ArcGIS Desktop
	ArcMap General
	Scale range enabling and disabling layers at the same scale (problem with Zoom to Previous Extent tool)

	CQ00159676
	ArcGIS Desktop
	ArcMap General
	Identify Results window—Add option to control which of the preset Layers options <Top Most>, <All>, etc., is default

	CQ00165599
	ArcGIS Desktop
	ArcMap General
	Provide a utility to allow backward/reverse compatibility of map documents (.mxd files). Currently not reverse compatible.

	CQ00182435
	ArcGIS Desktop
	ArcMap General
	Clicking the Help button in the Graph Properties > Advanced Options dialog box returns an error

	CQ00208434
	ArcGIS Desktop
	ArcMap General
	Identify Results window—Add shortcut to expand all entries to make working with results from multiple layers easier

	CQ00220291
	ArcGIS Desktop
	ArcMap General
	TOC—Add support for CTRL+SPACE BAR keyboard shortcut to toggle all the layers on/off in data frame

	CQ00234516
	ArcGIS Desktop
	ArcMap General
	Identify Results window incorrectly reports “Nothing Found” when waiting for results

	CQ00235474
	ArcGIS Desktop
	ArcMap General
	In layout view in a map with a legend, there’s a delay when checking/unchecking layers in TOC before check box responds

	CQ00235478
	ArcGIS Desktop
	ArcMap General
	ArcMap View pull-down menu—The letter D is used twice for underscore shortcut; change Grid to use I instead of D

	CQ00235583
	ArcGIS Desktop
	ArcMap General
	ArcMap crashes if using AddDataDialog to add data containing both network and feature classes with unregistered class extensions

	CQ00238370
	ArcGIS Desktop
	ArcMap General
	Advanced Utilities Settings monitor registry key stores wrong value

	CQ00239295
	ArcGIS Desktop
	ArcMap General
	Add the Pause Drawing tool to the Standard toolbar

	CQ00245353
	ArcGIS Desktop
	ArcMap General
	When the middle vertex is deleted from a graphic line with three vertices, ArcMap fatals

	CQ00249383
	ArcGIS Desktop
	ArcMap General
	The Save dialog box appears really big when using File>Save on an exported map that has not been saved before

	CQ00249475
	ArcGIS Desktop
	ArcMap General
	TOC scroll position resets when a change in scale causes a layer with scale ranges to change visibility

	CQ00249684
	ArcGIS Desktop
	ArcMap General
	TOC gets and retains keyboard focus whenever change to map scale causes a layer with scale range to be drawn or not drawn

	CQ00254781
	ArcGIS Desktop
	ArcMap General
	Memory leak when setting projected coordinate system properties

	CQ00256734
	ArcGIS Desktop
	ArcMap General
	Save As dialog box defaults to wrong location in some contexts due to unexpected dependency with File>Export dialog box

	CQ00257824
	ArcGIS Desktop
	ArcMap General
	Overview Window—Extent rectangle not shadowed when moved in 9.x

	CQ00257886
	ArcGIS Desktop
	ArcMap General
	ArcMap DOS prompt commands can cause ArcMap to crash on startup + other issues

	CQ00258210
	ArcGIS Desktop
	ArcMap General
	Zoom to selected features does not work for layers in a group layer

	CQ00260041
	ArcGIS Desktop
	ArcMap General
	Pressing F1 when the map has keyboard focus launches Help>About dialog box as well as desktop Help. Should just launch the Help

	CQ00261821
	ArcGIS Desktop
	ArcMap General
	Change message when adding multiple layers, some with undefined projection

	CQ00262067
	ArcGIS Desktop
	ArcMap General
	Need to add message to identify data source incompatibilities when “Save a Copy...” is called

	CQ00263235
	ArcGIS Desktop
	ArcMap General
	ArcMap crashes when using Auto-Cache and switching between data view and layout view

	CQ00264496
	ArcGIS Desktop
	ArcMap General
	Error message when opening map document fails is not informative, should be improved

	CQ00264778
	ArcGIS Desktop
	ArcMap General
	Save/Save As dialog box defaults to the wrong path when no value is set in HKCU

	CQ00071920
	ArcGIS Desktop
	ArcMap Layers
	Median value should be added to the classification statistics

	CQ00096953
	ArcGIS Desktop
	ArcMap Layers
	Classification dialog—Custom Min/Max options are never available

	CQ00112524
	ArcGIS Desktop
	ArcMap Layers
	Chart symbols—Set Imarker.Yoffset not working properly

	CQ00114735
	ArcGIS Desktop
	ArcMap Layers
	Sized pie charts and proportional symbols don’t handle values <= 0 very well

	CQ00115562
	ArcGIS Desktop
	ArcMap Layers
	Classification dialog>Sampling dialog—Apply button on sampling dialog does nothing

	CQ00133686
	ArcGIS Desktop
	ArcMap Layers
	Manage Hyperlinks dialog—Type radio button pair doesn’t really make sense

	CQ00133925
	ArcGIS Desktop
	ArcMap Layers
	Hyperlinks dialog (dialog that appears if more than one hyperlink is available)—List should always have one entry selected

	CQ00133927
	ArcGIS Desktop
	ArcMap Layers
	Manage Hyperlinks dialog—Remove All button should only be disabled if there are no hyperlinks in the list

	CQ00134724
	ArcGIS Desktop
	ArcMap Layers
	Manage Hyperlinks dialog—1) Edits to paths in the list never accepted, 2) Dirty flag not set by anything in this dialog

	CQ00135470
	ArcGIS Desktop
	ArcMap Layers
	Pie charts—If no fields are added, no leader lines should be drawn on the map

	CQ00140371
	ArcGIS Desktop
	ArcMap Layers
	Display problem when using dynamic hyperlinks and multiple data frames

	CQ00140377
	ArcGIS Desktop
	ArcMap Layers
	Hyperlinks dialog—Improve user experience when Hyperlink tool picks up multiple features from one or more layers

	CQ00140476
	ArcGIS Desktop
	ArcMap Layers
	Fields in joined tables aren’t working correctly as source for field-based hyperlinks

	CQ00141091
	ArcGIS Desktop
	ArcMap Layers
	Allows adding hyperlink for features in layers based on non-OID tables, but the links are not saved

	CQ00141310
	ArcGIS Desktop
	ArcMap Layers
	Classification dialog—Remove Advanced Statistics button

	CQ00141347
	ArcGIS Desktop
	ArcMap Layers
	Convert Features To Graphics dialog—Rename “Target” combo to “Target Annotation Group”

	CQ00143737
	ArcGIS Desktop
	ArcMap Layers
	Display tab takes too long to load when there are relatively few features excluded

	CQ00148988
	ArcGIS Desktop
	ArcMap Layers
	Feat2Graphics for graduated symbols on polygon features not working

	CQ00156414
	ArcGIS Desktop
	ArcMap Layers
	Pie charts do not display when data is from Excel (OLE DB) and is an XY Event in the map

	CQ00157899
	ArcGIS Desktop
	ArcMap Layers
	Layer Properties dialog > Display tab—Restore Drawing tool only restores one feature at a time, should work for multiple

	CQ00161949
	ArcGIS Desktop
	ArcMap Layers
	Need a way to control the search tolerance of the Hyperlink tool

	CQ00162374
	ArcGIS Desktop
	ArcMap Layers
	Hyperlink base should not add a back slash (\) to the end of the path

	CQ00173408
	ArcGIS Desktop
	ArcMap Layers
	Pie charts—Geographic option is incorrect when “Prevent Chart Overlap” is checked

	CQ00182911
	ArcGIS Desktop
	ArcMap Layers
	Changing outline color for proportional symbols > Known units changes fill color instead

	CQ00195204
	ArcGIS Desktop
	ArcMap Layers
	Layer files (.lyr) are not backward/reverse compatible with version earlier than the one with which they were created 

	CQ00211795
	ArcGIS Desktop
	ArcMap Layers
	Layer Properties Source tab—Add angular units if coordsys is geographic

	CQ00213845
	ArcGIS Desktop
	ArcMap Layers
	Layer Properties dialog > Symbology tab—Minor UI issues

	CQ00217975
	ArcGIS Desktop
	ArcMap Layers
	Export data should remember last used location

	CQ00225597
	ArcGIS Desktop
	ArcMap Layers
	Implement better message handling and fix so that a message appears for each layer with a problem, not just the last one in the TOC

	CQ00230944
	ArcGIS Desktop
	ArcMap Layers
	Pie chart symbology for line features cannot be converted to graphics

	CQ00231663
	ArcGIS Desktop
	ArcMap Layers
	Export Data dialog—Very inefficient GUI validation on the layer > data export dialog in ArcMap

	CQ00239938
	ArcGIS Desktop
	ArcMap Layers
	CadLayer without DataSourceName crashes when loading from stream

	CQ00242347
	ArcGIS Desktop
	ArcMap Layers
	If an empty layer is added to ArcMap through code and it is then removed, ArcMap will crash

	CQ00244540
	ArcGIS Desktop
	ArcMap Layers
	Exporting in DF’s coordinate system not working if DF and raster coordsys are the same.

	CQ00245651
	ArcGIS Desktop
	ArcMap Layers
	Drag and Drop Expand and Collapse Sub-Layer onto toolbar causes crash

	CQ00246243
	ArcGIS Desktop
	ArcMap Layers
	Layer Properties dialog > Source tab—When coordinate extents are inaccessible or unknown, values show as “1.#QNAN0”

	CQ00246624
	ArcGIS Desktop
	ArcMap Layers
	DataFrame does not refresh when a standalone CompositeGraphicsLayer is turned off

	CQ00250568
	ArcGIS Desktop
	ArcMap Layers
	Hyperlinks dialog—When using multiple hyperlinks, the Hyperlinks dialog box cannot be resized

	CQ00252961
	ArcGIS Desktop
	ArcMap Layers
	Convert Features to Graphics piles up pie chart symbols and loses leader lines

	CQ00253052
	ArcGIS Desktop
	ArcMap Layers
	Convert Features to Graphics—Dialog is empty if started from a layer in inactive data frame or from inactive data frame

	CQ00253196
	ArcGIS Desktop
	ArcMap Layers
	Dot Density and Chart symbol property pages crash when attempting to add new level to symbol

	CQ00253199
	ArcGIS Desktop
	ArcMap Layers
	Chart symbol elements have bad refresh and experience with callouts

	CQ00258191
	ArcGIS Desktop
	ArcMap Layers
	Crashes with proportional symbology on personal geodatabase float field with null values

	CQ00263491
	ArcGIS Desktop
	ArcMap Layers
	Layer transparency values can become out of sync with simple GUI operations

	CQ00264243
	ArcGIS Desktop
	ArcMap Layers
	Panning with cartographic/hash/marker symbol does not refresh all layers

	CQ00112905
	ArcGIS Desktop
	ArcMap Layout/MapElements
	Would be good to draw white background when drawing drop shadow

	CQ00135741
	ArcGIS Desktop
	ArcMap Layout/MapElements
	Frame tab—Drop shadow X and Y offsets on frames shouldn’t default to 0

	CQ00226998
	ArcGIS Desktop
	ArcMap Layout/MapElements
	Expose Ilegend2 so that “Scale Symbols When a Reference Scale is Set” on the Legend Properties dialog can be set

	CQ00229666
	ArcGIS Desktop
	ArcMap Layout/MapElements
	Layer name not displayed in legend after changing layer symbology renderer

	CQ00238241
	ArcGIS Desktop
	ArcMap Layout/MapElements
	Legend wizard—Going back to first page shouldn’t clear non-visible layers from list

	CQ00238842
	ArcGIS Desktop
	ArcMap Layout/MapElements
	Remove redundant commands in Page Layout category: Activate Next Data Frame/Activate Previous Data Frame

	CQ00241212
	ArcGIS Desktop
	ArcMap Layout/MapElements
	Legend Item Selector—Properties button should be disabled if you can’t open properties when more than one item is selected

	CQ00241213
	ArcGIS Desktop
	ArcMap Layout/MapElements
	Legend Properties—Make it easier to change the text symbol used by multiple legend items

	CQ00242716
	ArcGIS Desktop
	ArcMap Layout/MapElements
	Legend item description font style reverts back to original settings

	CQ00242940
	ArcGIS Desktop
	ArcMap Layout/MapElements
	Scale text value should not change when changing page layout units to points

	CQ00244099
	ArcGIS Desktop
	ArcMap Layout/MapElements
	Change font with Draw toolbar only changes Legend title font

	CQ00244694
	ArcGIS Desktop
	ArcMap Layout/MapElements
	Some Map Connection options don’t auto refresh symbols in legend

	CQ00244813
	ArcGIS Desktop
	ArcMap Layout/MapElements
	Legends in 8.3 map docs change when opened in 9.0 and can’t be fixed.

	CQ00247320
	ArcGIS Desktop
	ArcMap Layout/MapElements
	Grouped elements are missing when opening an 8.2 .mxd in 9.0

	CQ00248127
	ArcGIS Desktop
	ArcMap Layout/MapElements
	Font size of scale text changes after different actions

	CQ00250613
	ArcGIS Desktop
	ArcMap Layout/MapElements
	North Arrow, scale bar, scale text do not retain size when moved

	CQ00259030
	ArcGIS Desktop
	ArcMap Layout/MapElements
	Maps draw with the wrong reference scale when the map frame intersects the bounds of the page

	CQ00219175
	ArcGIS Desktop
	ArcMap Map Services
	ArcIMS Image Service > Layer Properties dialog > Source tab—Add unit abbreviations to the extent values

	CQ00260409
	ArcGIS Desktop
	ArcMap Map Services
	Give users ability to suppress the “stock” login dialog for secure services

	CQ00265193
	ArcGIS Desktop
	ArcMap Map Services
	Opening existing map document with MapServer object (many layers) takes > 2 min

	CQ00248780
	ArcGIS Desktop
	ArcMap Output
	ArcPress needs to support the new HP Designjet 4000

	CQ00250742
	ArcGIS Desktop
	ArcMap Output
	Inserted EMF images report font names incorrectly, creating font problems in postscript export formats (AI, PDF, EPS)

	CQ00251119
	ArcGIS Desktop
	ArcMap Output
	PDF, EPS, and AI export do not correctly support type1 OTF (OpenType fonts)

	CQ00255440
	ArcGIS Desktop
	ArcMap Output
	ArcMap crashes on batch export of Kanji text to PDF (GDI leak when font embedding on)

	CQ00257246
	ArcGIS Desktop
	ArcMap Output
	Post SP2—Wingdings (and possibly other) fonts in a text element cause error when opening in Adobe Acrobat

	CQ00257356
	ArcGIS Desktop
	ArcMap Output
	Text elements referring to missing font break embedding in PDF, EPS, and SVG

	CQ00257663
	ArcGIS Desktop
	ArcMap Output
	Make the Options drop-down on the Export Map dialog more visible

	CQ00101038
	ArcGIS Desktop
	ArcMap Selection
	Select By Attributes dialog/Query Builder—Make it easier to work with long fields and values

	CQ00108375
	ArcGIS Desktop
	ArcMap Selection
	Zoom To Selected Features—Zoom To option to display selected features despite scale limits

	CQ00122300
	ArcGIS Desktop
	ArcMap Selection
	Select By Attributes dialog—Expression box should add vertical scroll bars

	CQ00131058
	ArcGIS Desktop
	ArcMap Selection
	TOC Selection tab and Set Selectable Layers dialog—if you press SPACE to unselect a layer, it doesn’t persist (508)

	CQ00143908
	ArcGIS Desktop
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